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Overview

Thus far, we have relied on the tools to configure the Zyng PS properly. Although it wasn’t
explicitly pointed out previously, performing a Run As or Debug As operation in SDK first sources
the ps7_init._tcl file that was created during the export to SDK. In a true, embedded
application, you will not have a JTAG cable connection that can transfer these settings. Your code
must be able to do this before transferring control to an application. The code that sets up the
Zynq PS is called the First Stage Boot Loader (FSBL).

Objectives

When this tutorial is complete, you will be able to:
e Create the FSBL
e Prepare the boot image
e Write and boot from QSPI

Experiment Setup

Software
The software used to test this reference design is:
e Windows-7 64-bit
e Xilinx SDK 2017.1
e FTDI FT2232H device driver
Hardware
The hardware setup used to test this reference design includes:
e Win-7 PC with the following recommended memory?:
0 1.6 GB RAM available for the Xilinx tools to complete a XC7Z010 design
O 2.3 GB RAM available for the Xilinx tools to complete a XC7Z015 design
0 1.9 GB RAM available for the Xilinx tools to complete a XC7Z020 design
O 2.7 GB RAM available for the Xilinx tools to complete a XC7Z030 design
e MiniZed

e USB cable (Type A to Micro-USB Type B)
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Experiment 1. Create the FSBL

The first step is to create the FSBL application. This is a C program that embeds all the Zynq
internal register settings that were established during the Vivado Block Design.

Similar to the flow for creating the Hello_World application, in SDK create a First Stage
Bootloader application.

1. Launch SDK and open the workspace from the Hello World project.
2. File > New =2 New Application Project

3. Name it something like ZED_FSBL and Create New BSP. The reason for creating a new BSP
is that the FSBL BSP requires a library for the Flash, and the tools will automatically include
this for us if we allow it to create the BSP. Click Next

@ Mew Project l ] eS|
Application Project >
Create a managed make application project. &
Project name: ZED_FSEL]| 1

V1 Use default location )
ChAvnet\MicroZed\Applications\MZ_basic_system'\ZED_FSE Browse...

default

05 Platform: ’standalone v]
Target Hardware
Hardware Platform: ’hw_platform_ﬂ v] ’New]
Processon ’ps?_cortexag_ﬂ V]
Target Software
Language: @C ) C+s

32 bit 2

Board Support Packag4 @) Create Mew  7ED_FSBL_bsp

(@) Use existing | standalone_bsp 0

Figure 1 — FSBL Application

I [ Finish ] ’ Cancel
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4. Select Zynq FSBL

5. Click Finish
B New Project - l (5] ﬂh,l

Templates »
Create one of the available templates to generate a fully-functioning \E
application project.

Avvailable Ternplates:
Dhrystone First Stage Bootloader (FSEL) for Zyng, -
Empty Application The FSBL configures the FPGA with HW
Hello World bit stream (if it exasts) and loads the
lwiP Echo Server Operating System (05) Image or
Memory Tests Standalone (54) Image or 2nd Stage Boot
OpenAMP echo-test Loader image from the nen-volatile
OpenAMP rmatrix multiplication Demo merncry (NAND/MOR/QSPI) to RAM
OpenAMP RPC Demo (DDR) and starts executing it. It supports
Peripheral Tests multiple partitions, and each partition
RS54 Authentication App can be a code image or a bit stream.

Eﬁn? DRAM tests

@ Next > Finish | [ Cancel

Figure 2 — Zynq FSBL Template for Application

6. Similar to the standalone_bsp 0 we created in lab 2, we must modify the BSP’s UART
settings to properly output our results through the serial port. In the ZED_FSBL_bsp
system.mss file click on “Modify this BSP’s Settings”.
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system.hdf i, system.mss memorytest.c memory_config_g.c [}, system.mss &3 = 4
ZED_FSBL_bsp Board Support Package &

I[ Maodify this BSP's Settings I[ Re-generate BSP Sources

Target Information

This Board Support Package is compiled to run on the following target.

Hardware Specification: C:\Avnet\MiniZed'\Applications\MiniZed_Basic_System\hw_platform_0\system.hdf
Target Processor psi_cortexad_0

m

Operating System

Board Support Package OS.
Mame: standalone
Version: 6.2

Description:  Standalone is a simple, low-level software layer. It provides access to basic processor features such as caches, interrupts and exceptions as well as the basic features of a hosted —
environment, such as standard input and cutput, profiling, abort and eat.

Documentation: standalone v6 2

Peripheral Drivers

Drivers present in the Board Support Package.

ps7_afi_0 generic Decumentation
ps7_afi_1 generic Documentation
psi_afi_2 generic Documentation
psi_afi_3 generic Doecumentation

ps7_coresight_comp_0 coresightps_dcc Documentation

ps7_ddr0 ddrps Documentation
ps7_ddrc_0 generic Documentation
ps/_dev_cfg_ 0 devcfg Documentation Import Examples
psi_dma_ns dmaps Documentation [mport Examples
psl dma s dmaps Decumentation Import Examples .

Overview | Source

Figure 3 -- Modify BSP

7. Inthe Board Support Package Settings, select standalone

Page 4

Copyright © 2017 Avnet, Inc. AVNET, “Reach Further,” and the AV logo are registered
trademarks of Avnet, Inc. All other brands are the property of their respective owners.

LIT#



/MINIZED

AAVNET

Reach Further™

@ Board Support Package Settings

[SE)

Board Support Package Settings
Control various settings of your Board Support Package.

# | Overview
ZED_FSBL_bs
wlffs 05Type:  standalone
4 drivers 05 Version: 6.2 =
ps7_cortexal_0
Target Hardware

Standalone is a simple, low-level software layer. It provides access to basic processor
features such as caches, interrupts and exceptions as well as the basic features of a
hosted environment, such as standard input and cutput, profiling, abort and exit.

Hardware Specification: C:\Avnet\MiniZed\Applications\MiniZed_Basic_System\hw_platform_0\system. hdf

Processor:

ps7_cortexad 0

Supported Libraries

Check the box next to the libraries you want included in your Board Support Package.You can configure the library in the

navigator on the left.

MName Version Description
[T libmetal 1.2 Libmetal Library
[ wipl4l 18 IwlP TCP/IP Stack library: IwIP v1.4.1
[] openamp 13 OpenAmp Library
xilffs 3.6 Generic Fat File System Library
[T] xilflash 43 Kilinx Flash library for Intel/AMD CFI compliant paral...
[T xilisf 5.8 Xilinx In-system and Serial Flash Library
[T xilmnfs 23 Kilinx Mermory File System
[T xilpm 21 Power Management API Library for ZyngMP
zilrsa 13 Kilinx RSA Library
[T xilskey 6.2 Kilinx Secure Key Library

| [ Cancel

Figure 4 — Board Support Package Settings

8. Change the stdin and stdout Value to ps7_uart. This is done to align with the MiniZed’s

UART Serial connection. Select OK.

Mame
hypervisor_guest
stdin
stdout
myngmp_fsbl_bsp

Value Default Type Description

false false boolean Enable hypervisor guest su
psf_uart 1 none peripheral stdin peripheral

psf_uart 1 none peripheral stdout peripheral

false false boolean Disable or Enable Optimiz:
false false boolean Enable MicroBlaze Excepti
false false boolean Enable 5/W Intrusive Profil

Figure 5 — Modify stdin/stdout

Based on the modified settings in SDK, the BSP will automatically be built once it is added
to the project. This may take a minute to compile the new BSP. The progress may be
seen in the Console tab.
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Experiment 2: Prepare the Boot Image
The next step is to create a non-volatile boot image. MiniZed has one non-volatile, primary
bootable source, QSPI.

1. InSDK, select Periph_Test.

[ Project Explorer 33
. =% Hello_Zed
. g hw_platform_0
. =% Mem_Test
- |5 Periph_Test
> f@: standalone_bsp_0
. % ZED_FSBL
. il ZED_FSBL_bsp
. % ZyngDRAM_Test

Figure 6 — Select Application to Boot

2. Select Xilinx Tools > Create Boot Image.

m MiniZed_Basic_System - C/C++ - ZED_FSBL_bsp/system.mss - Xilinx SDK
File Edit Mavigate Search Project Run | Xilinx Tools | Window Help

N | B v &% v i iw Tl Generate linker script

i, Board Support Package Settings
[y Project Explorer &3 Repositories
. =% Hello Zed
. g hw_platform_D Program FPGA
. =% Mem_Test Dump/Restore Data File

- |25 Periph_Test

. ﬁ@: standalone_bsp_0
. 5 ZED_FSBL

- M ZED_FSBL_bsp

- 25 ZynqDRAM_ Test

Program Flash

Launch Shell
KSCT Console

DEf 9 D=

Create Boot Image

Figure 7 - Create Zynq Boot Image
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This will preload the FSBL ELF, bitstream, and Application ELF images. The order of the files is
important. The FSBL is first, followed by the bitstream, followed by the Application. One function
of the FSBL is to program the PL. After the PL is configured, the application is loaded.

File path Encrypted Authern
(bootloader) ChAvnet\MiniZed\Applications'\MiniZed_Basic_Systerm\ZED_FSBEL\Debugh\ZED_FSBL.elf none none
Chavnet\MiniZed\Applications\MiniZed_Basic_System‘\hw_platform_0\Systern_wrapper.bit none none
Chavnet\MiniZed\Applications\MiniZed_Basic_Systern\Periph_Test\Debug'\Periph_Test.elf none none

Figure 8 — Boot Image Partitions

Notice that by default, the output path points to BOOT.bin (highlighted), which is the bootimage
required for SD boot. Unfortunately the MiniZed by default is unable to boot from SD Card, the
output image must be changed to generate a QSP| bootimage (mcs).

m Create Boot Image @1

Create Boot Image
Creates Zyng Boot Image in .bin format from given FSBL elf and partition files in specified output folder, _@
Architecture:

(@) Create new BIF file (©) Import from existing BIF file

Basic | Security

Output BIF file path:  C:\Avnet\MiniZed\Applications\MiniZed_Basic_System'\Periph_Test\bootimage\Periph_Test.bi

UDF data:
[T 5plit Output format:
Output path: ChAvnet\MiniZed\Applications\MiniZed_Basic_System\Periph_Test\bootimage\BOOT bin

Boot image partitions

File path Encrypted A
(bootloader) ChAvnet\MiniZed\Applications\MiniZed_Basic_System'\ZED_FSEL\Debug\ZED_FSBEL.elf none n
ChAvnet\MiniZed\Applications\MiniZed_Basic_System\hw_platform_0"System_wrapper.bit none n
Chfwnet\MiniZed\Applications\MiniZed_Basic_Syster'Periph_Test\Debug\Periph_Test.elf none n
Edit
':?3' [Preview BIFChanges] [ Create Image ] [ Cancel ]

Figure 9 — Create Image

3. Change the Output format to *.mcs. Change Boot.mcs to Periph_Test.mcs for the
File name.
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[ m Create Boot Image Iﬁ‘

Create Boot Image

Creates Zyng Boot Image in .mcs format from given FSBL elf and partition files in specified output folder. _@

Architecture:

@ Create new BIFfile () Import from existing BIF file

Basic | Security

Output BIF file path:  C\Avnet\MiniZed\Applications\MiniZed_Basic_System'Periph_Test\bootimage\Periph_Test.bi

UDF data:
[ split Output format:
Output path: Avnet\MiniZed\Applications\MiniZed_Basic_System'\Periph_Test\bootimage\Periph_Test.mes | | Browse...

Boot image partitions

File path Encrypted A

(bootloader) ChAvnet\MiniZed\Applications\Minifed_Basic_Systerm\ZED_FSBL\Debug\ZED_FSEL.elf none n

ChAvnet\MiniZed\Applicatiens\MiniZed_Basic_System'\hw_platform_0\System_wrapper.bit none n

ChAvnet\MiniZed\Applicatiens\MiniZed_Basic_System‘\Periph_Test\Debug\Periph_Test.elf none n
Edit
D

- :

@' ’Preview BIF Changes] [ Create Image ] I Cancel ]

Figure 10 — Creating the QSPI Bootimage

4. Click Create Image.

5. Using Windows Explorer, navigate to the application directory, then into Periph_Test,
then into the newly created bootimage directory. Notice that two files have been created:
.bif, .mcs. These are all the required files to program either the QSPI or SD Card.

-

@I\H)'| . » Computer » OSDisk (C:) » Avnet » MiniZed » Applications » MiniZed_Basic_System » Periph_Test » bootimage

Organize = Include in library = Share with = Burn New folder
¢ Favorites Mame : Date maodified Type Size
Bl Desktop |Z] Periph_Test 6/1/2017 40 AM BIF File 1KE
&4 Downloads || Periph_Test.mcs 6/7/2017 9:40 AM M5 File 6,227 KB

Figure 11 - Bootimage Directory
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Experiment 3: Write and boot from QSPI
First, we will program the QSPI with the MCS file from within SDK.

1. Set up the MiniZed for Cascaded JTAG mode as before. Attach the micro-USB to J2 and
your computer.

2. In SDK, select Xilinx Tools = Program Flash.

3. Click the Browse button, and browse to the MCS image for the application you wish to
program. Select it and click Open. You can selectively enable the Blank check after erase
and/or the Verify after flash functions although each of these will add time to the
procedure. Neither is required to program the Flash.

4. Click Program.

Program Flash Memory

Pregram Flash Memeory via In-system Programmer,

! [E

Hardware Platform: [hw_platfcrrm_ﬂ ']
Connection: [Local v] ’ Mew ]
Device: Auto Detect
Image File: ChAvnet\MiniZed\Applications\MiniZed_Basic_System\Periph_Test\bootimage\Periph_Test.mcs
Offset:
Flash Type gspi_single v]
Browse
Convert ELF to bootloadable SREC format and program

[7] Blank check after erase
[ verify after flash

'/?\' Program Cancel

P g

Figure 12 — Program QSPI Flash Memory

5. The operation took approximately 40 seconds on a Win7 PC. You should see the following
in the Program Flash Console window (if you see nothing in the console window, click the

console pull-down B~ and select Program Flash).
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Initialization done, programming the memory
BOOT_MODE REG = @xpoapaeos

f probe @ 2 @

Performing Erase Operation...

Erase Operation successful.

INFO: [Xicom 58-44] Elapsed time = 5 sec.
Performing Program Operation...

8%...7e%. ..1ee%

Program Operation successful.

INFO: [Xicom 5@-44] Elapsed time = 15 sec.

Flash Operation Successful

Figure 13 — QSPI Programmed Successfully

6. Power off the board by unplugging J2 micro-USB connector.

7. Set the MiniZed boot mode switch SW1 to QSPI mode (‘F’ for Flash) as shown below.
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Figure 14 — MiniZed Switch Location
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1 <PL-SW> 0

Ty,
©
1 4
B
=

r24

Figure 15 — QSPI/Flash Boot Mode

8. Close or disconnect the terminal that may have previously been open on your PC.

9. Power on the board by reconnecting the USB-JTAG-UART J2 connection. A blue LED
should illuminate meaning the bitstream was loaded.

10. Launch a terminal program (TeraTerm) with the 115200/8/n/1/n settings.

11. Push the RESET button (SW2). You should see the results in the terminal.
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7 COM2S - Tera Term VT = B

File Edit Setup Control Window Help
———Entering main—— -

Running ScuGicSelfTeztExample<? for ps?_scugic_A...
ScuGicSelfTestExample PASSED
SculGic Interrupt Setup PASSED

Running XDmaPs_Example W_Intr<{> for ps?_dma_s...
Teszt round A
HDmaPs_Example_UW_Intr PASSED

Running IicPsSelfTestExample<> for p=Y_iZ2c_A...
IlicPsSelfTestExample PASSED

Running QspifelfTestExample<> for ps?_gspi B@...
QzpiPzSelfTestExample PASSED

Running DcocfgSelfTestExample<> for ps?_dev_cfg A...
DefgSelfTestExample PASSED

Running SculimerPolledExample<> for ps?_scutimer_@...
Scul imerPolledExample PASSED

RBunning Interrupt Test for ps?_scutimer_@...
SculimerIntrExample PASSED

Running Interrupt Tezt for ps¥_scuwdt_@...
Sculldt IntrExample PASSED

Running UartPzPolledExample<{> for ps?_uart_@.._.
lartPsPolledExample PASSED

RBunning Interrupt Test for ps? _uvart_B@.._.
HartPszIntrExample PASSED
——Exiting main——

Figure 16 — Results from QSPI boot of Periph_Test

12. Close the terminal. Power off the board.
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Revision History

26 Aug 2013 2013_2.01 Initial Avnet release for Vivado 2013.2

06 Sep 2013 2013 _2.02 Switching to Release build rather than Debug

10Jun 2014 2014 _1.01 Update to 2014.1. Added instructions that .bin and .mcs must
each be generated individually now.

11Jun 2014 2014 2.01 Update to 2014.2. Bitstream must manually be added to the Boot
Image dialog now.

29Jun 2015 2015_1.01 Update to 2015.1. Bitstream is no longer manual. Add support for
PicoZed.

15Jul 2015 2015_2.01 Update for 2015.2

06 Apr 2016 2015_4.01 Update to 2015.4. Add support for PZCC-FMC-V2.

01Jun2016 2015 _4.02 Update to 2015.4. Clarified USB to Uart cable connection.

15 Sept 2016 2016_2.01 Updated to 2016.2

20Jan 2017 2016_4.01 Updated to 2016.4

07 Jun 2017 2017_1.01 Updated to 2017.1 for MiniZed
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